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Total station instrument introduction 
ټل ستيشي تعزيفد ټو  

پَ  زُغَ تل ؼتیفي ػثاضت زُغَ الکتطًّکی آلی څرَ زی چَټْ  

یا  ّضی ًمطییْی هؼیٌی ًمطی څرَ ىـْچَ ز كْلايکوک ؼطٍ 

    ـطق ؼطٍ اُّوساضًګَ پَؼیکفًٌَْ پَ افمي فاللْزـوال اّ

.ّزؼطحي ؼطٍ تؼیي کړػوْزي هْلیؼیت زتحط  

زکْضزیٌاتْپَ ضڼاکَ زځوکی پَ   GPSکْلاـی ز ؼتیفي ټْټل یؼٌي.

اّزا ًوْړی آلَ ؼطٍ لَ  پیساکْيهفرمات ؼیکفي کَ ُطٍ ًمطَ اّ

پَ ػوْزیت،ز پل ؼاذتواى ډیطّ آؼاًیْکْلای ـی چَ زتؼویطاتْ

،زځوکْزهؽاحت تطثیك  ز پل زپایی زؼاذتواى ذط اًساظي،

اؼي ًْضّاًساظٍ اُّوسلایي زپیساکْلْ،پیساکْلْ،زؼٌتط

. ّاچّْپَ کاضلپاضٍ یطیْاّتطثیماتْک

ـویطل کیږی چَ ز ُغی پَ زلت  څرَیْزُغَ آلْ ؼتیفي ټْټل

 .ؼْيیْ لْړ تاّض تَ ض ظهًْږکاضؼط

تلی  ُیځ ّذت کَل ُغَ آلَ زٍ چَ زؼطّی پَ ټْ لْحالاتْیؼٌی ټْټ

ؼطتَ ضؼْی چَ  ؼطٍ زلتآلی تَ احتیاج ًَ لطی اّټْل کاضًَّ پَ ډیط

  .کَ زی 0.000mزلت پَ  آلیّهړی ز ى

زاؼتؼوال لپاضٍ ډیطٍ ځیطکتیا پکاضزٍ ؼتیفي ټل پَ ُوسی آؼاغ زټًْْ

څرَ کاض ّض زلتډیط پَکَ تایس  اّهطحلَ ؼطّی پَ ُطٍ تطذَچَ ز

 .ّاذؽتل ـی

اًْاع ټْټل ؼتیفًٌَْ کاضیږي اُّطٍ ؼٌي ػمطکَ ډیطّزاچَ پَ ا

ّهي ډّل پَ لاًسي ًْػَ ځاًتَ کاضتطز اّهفرمات لطي چَ پَ ػن

کَ تَ ُطٍ ًْػَ زاؼتؼوال اّپَ زي ډّلًْْ. تمؽین ـْي زياًْاػًْْ

. لَ ًظطٍ هؼطفي ـي
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Types of Total station 

د ټو ټل ستيشي اًواع 
ز زی اّ هْجْ زټْټل ؼتیفي اًْاع ظیاتلکَ څطًګَ چَ پَ ًړی کَ 

ُغْ ز چَ زجْړٍ ـْي ٍ ًْػَ پَ تیلاتیلا هفرماتْاّکاضتطزًّْاُّط

 .ًوْړي آلي اؼتؼوالیږيجولْ

LEICA  

COLIDA 

TOPCON 
NICKON 
SOKKIA 

ظیاتَ  څرَي ًْع SOKKIA کَ یْاظي زچَ پَ زي شکطـًّْْػْ

اّزاًْضي ًْػي ُغَ ًْػي زي چَ پَ کوَ فیمسي اؼتفازٍ کیږی 

. ّضڅرَ اؼتفازٍ کیږي

پَ ُوسی لکَ څطًګَ چَ هْزؼْکیا پَ اړٍ هْهؼلْهات ّلْؼتل ًْ

ؼْکیا ًْػَ اًتراب کړی چَ پَ پْضٍ تفمیل ؼطٍ تَ یی هْؼثة 

. ّګْضيػولي اّ ٍزاؼتؼوال ططیك

پَ اّل لسم کَ تایسّپُْیږّچَ ټْټل ؼتیفي زکْهْاجعاّّڅرَ تفکیل 

. پَ اړٍ هؼلْهات ّلطّّزػولکطزـْي اّزُغَ زُطي اجعا

اړٍ یا کاضتطز پَ ػولکطززُغَ زي ځاي کَ زُطي اجعاًْم تیاًّْاّپس

. کّْػول ضیمَ پَ لاًسط
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Parts of Total station 

 د ټوټل ستيشي اجشاوی
ټْټل ؼتیفي لطًّکي زظیاتْاجعاّّزي چَ ُطٍ یٍْ یي ذاق کاضًَّ 

پػ زُطي اجعاکړًلاضٍ پَ لاًسي اًتراب ـّْ ـواضّکَ  اًجاهْي

  .ّګْضي
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 .کوپاغپیسا کْلْزهؽیط .1

 .زټْټل ؼتیفي زؼت ګیطیا زؼتَ .2

 .زټْټل ؼتیفي ززؼت ګیطپیچًَْ .3

  .زټْټل ؼتیفي کیفي تْجَ یاًفاى .4

 .ذطڅرَ زټْټل ؼتیفي زاضتفاع هؼلْهلْزځوکي زؼط .5

  .زټْټل ؼتیفي تلیؽکْب .6

 .زـثکی زضّښاًَ کْلْ یا فْکػ کْلْ پیچ .7

 .پیچزهحْضاتْ زضّښاًَ کْلْپَ تلؽکْب کَ   .8

 پیچ ّلاکْلْیا للف کْلز تلؽکْب ز .9

 .حطکت پیچز تلؽکْب زهایکطّهتطی  .10

 .آفتیکي ـالْل .11

 .پیچکْلْزـثکي زفْکػ یاّاضیحـالْل  آفتیک .12

 .پیچکْلْـالْل ززاذلي زایطي زّاضیح زآفتیکي .13

 .زټْټل ؼتیفي اؼتْاًْي آتتطاظّ .14

 . ؼکطیيزټْټل ؼتیفي کیثْضزاّ .15

 .پیچ حطکت ظاّیی هایکطّهتطیافمی  ؼتیفي ز ټْټل .16

 .پیچیاللف کْلْلاکْلْل زاففی زّضزز ټْټ .17

  .ـي کطّي آتتطاظّزټْټل ؼتي .18

  .زټْټل ؼتیفي زتؽْیي پیچًَْ .19
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Keyboard 

 کيثورد
لکَ ځطًګَ چَ ټْټل ؼتیفًٌَْ هرتلف کیثْضزًَّ اّهرتلف 

  SOKKAI 620 Edit Systemکاضتطزًَّ لطي پَ ُوسي آؼاغ ز
کیثْضز ُن زًْضّ هاـیًٌْْؼطٍ فطق لطي ًًْوړي کیثْضز ـکل 

  . ّګْضيلاًسي لؽوت کَ پَ اّزُغَ زکوي اُّوساضًګَ کاضتطز یي 

ززي کیثْضز زکوي پَ زٍّ تطذْ ّیفل ـْزي یْ ُغَ زکوي زي چَ 

ذاق کاضًَّ اًجاهْي اّتل ُغَ زّکوي زي چَ پَ هرتلفْلفحْ کَ 

 Functionاّ  Alphabet keyیؼٌي ز .هرتلف کاضًَّ اًجاهْي

key څرَ تفکیل ـْي زي.  
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General page 
دټوټل ستيشي عووهی صفحَ  

کواًس هی لفحَ لطًّکی زڅْهفرمْکواًسًّْزٍ چَ زُطػوْ 

. تفطیح پَ لاًسی لیؽوت کی ّګْضی

: پَ ػوْهی لفحَ کَ لاًسی کواًسًَّ هْجْز زی

زُغَ هازل تطذَ کَ تاؼی زهاـیي ًْػی ًْم اّزلفحی پَ پْضتٌی 

  .ًوثطّیٌی

پَ ُوسی . زی SOKKIAاّزًْػی ًْم یی (  Set 620)چَ هازل یی 

چَ تط، ّیطژى اُّوساضًګَ کاضی فایل اّزُغَ ًْم ؼلؽلَ زلْت ًن

ٍ زضی زی لفحی پَ آذطی تطذَ کاّ.زجاب پَ هماتل کَ ّالیغ زی

کواًسًَّ لیسل کیږی چَ ػثاضت زی لَ ًْض

:MAES/f1,MEM/f3,CONFG/f4    چَ ُطکواًس ذاق

. ّظیفَ پَ غاړٍ لطی

 MAES چَ ز f1  َتڼی پَ ؼطهْلؼیت لطی کاضی لفحْت

 .ن اؼتؼوالیږیپَ غطززاذلسّ

 MEM  زMemory ى حافظَ پَ هرفف زی چَ زټْټل ؼتیؿ

هیوْضی لطًّکی ز ّځای ـْی زٍ اُوسی کواًس کَ ځای پط

 . جاب زٍ

 CONFG  هرفف زConfiguration  ْزی چَ زآلی زتطتیثات

   .پَ غطن کاضیږیاّتٌظیواتْ
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Starting manual and some internal guide 

of Total 

ُغَ پَ اړٍ داخلی هعلوهات  الاًيذوکړًلارٍ اودد ټوټل دچ
تاًسی ؼیټ   Bench Markهرَ ټْټل پَ هطلْتَ ًمطَ یا  ز ُطڅَ ز

یی لیْل ـْی کّْپَ زاؼی حال کَ چَ کطّی اّاؼتْاًْی آتتطاظّ

. پَ تیٌچ هاضک تاًسی هطاتمت ّلطیّی اّ

ز زکوی پَ هطؼتَ آلَ ضّـي کړّاّ ONز ّضؼتَ هًْږکْلای ـْ

ON  چَ زا ُن ز  یږي ػوْهی لفحَ ذلاق ّضؼتًََ ز ففاضزکوی

. څرَ یٍْ کاضی لفحَ ـویطل کیږیزکاضی لفحْ ؼتیفي ټلټْ

 تاؼی تَ زػوْهی لفحی تَ زاذل ـْؼتیفي  ټلزټْکلَ چَ 

) Horizontal key (F1, F2, F3, F4 ْپَ اهتساز پطاتَ زکو

چَ پَ ػوْهی لفحَ  Meas/F1ّّیٌی چَ ػثاضت زی لَ کواًسًَّ 

. اؼتفازٍ تطیٌَ کیږیحْتَ ززاذلیسٍّ کاضی لفک

MEM/F3 یوْضی زی لکَ څطًګَ چَ ُطٍمف زچَ هرف 

 ټلټْحافظَ لطی پَ ُوسی آؼاغ  هفرمَ الکتطًّیکی آلَ یٍْ

ض ٍاّ لطي ًَحافظی زی چَ جولَ لػ جاتُْن لطًّکی ز  ؼتیفي

. ځای کړیًمطی ځای پط 10000جاب کْلا ـی 

لای ـْز ذپل ځاى لپاضٍ یْکاضی فایل کّاّپَ ُوسی هیوْضی کَ هًْږ

تْ طَ ـطکت پَ ًاهَ ُن تٌظین چَ جاب ز هطجْړکړّاُّن کْلای ـْ

یایي لَ هٌځَ  ًَ حصف زاضًګَ ّکْلای ـْچَ تیکاضٍ جاتُْنکړّاّ

. یْؼْ

ی ًْ  پَ ًیکی آلَ تطتیثات اّ تٌظیوات لطلکَ ځطًګَ چَ ُطٍ الکتطّ 

ـْآلَ پَ هرتلفْ کْلای هک هًْږپَ کُوسی آؼاغ ز تٌظیواتْ

تل زی لفحَ کی یْمهرتلفْکاضًّْتَ ػیاضٍ کړًّْپَ ٍاّّاحساتْ

چَ آلی   Conflagrationیؼٌی ز  CONFAG/F1کواًس چَ ز 

. ضتیثات اّ تٌظیوات زی تٌظېن کْیت
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چَ  Unitsآلی ّاحسات یؼٌی ززی کواًسپَ هطؼتَ کْلای ـْچَ ز

پَ  Temp, Press, Angle, Distanceػثاضت زی لَ 

. کړّ تٌظیناّ تطتیةیٌْهمساضًّْهغ

پَ هطؼتَ ظّیی   Observe conditionز اُّوساضًګَ ّکْلای ـْ

ـطق  Esterیا ـوال یاُن   North اُّن فاللی پَ لفطکْلّْز

 .تٌظین کړّتاًسی تطتیة اّ

Job  

کاری فايل يا جاب  
ټْټل آلَ یٍْ هؼیٌَ حافظَ لطی ًْلکَ څطًګَ چَ ُطٍ الکتطًّیکی 

پَ ُطجاب کَ تمطیثآ جاتًَْ اّ 10ظی زی چَ ضًکی زحافؼتیفي ُن ل

. کیساي ـيځای ًمطی ځای پط 10000

تْپْګطافی پَ یْهفرك فایل  یازی پَ ذاططچَ ظهًْږؼاحْی کاضز

 ًٍْیْکاضی فایل جْړّّچَ ُغَ فایل پَ یْکړّځای کی ځای پط

پَ ؼاحَ کَ کلَ چَ .کّْ  Rename  ((Editهفرك ًاهَ تاًسی 

. کَ ظذیطٍ کّْ Jobُغَ پَ یٍْ هفرك اّ هؼیي لًْْتْپْګطافی ّخ

چَ زی  ػثاضت زیْهؼیي فایل څرَ زیُسف  Job ز ُوساضًګَاّ

هًْږتَ ز تطثیك لپاضٍ یٍْ ًْی ډیعاًط ؼطٍپَ تؽلین کْلْهْازّذاهْ

 Data cable تَ زتطکوپیْ Jobهفرك اُّوسا .تؽلین کْیډاټا 

کواًسکَ لکَ ځطًګَ چَ زجاب پَ .کّْ   Downloadلاضی ز

چَ . زذالْکاضًّْلپاضٍ پَ کاضّړل کیږیًْضکواًسًَّ ُن ـتَ چَ 

: ػثاضت زی لَ

Job selection  
Job name edit  

Job deletion  

Comms output 

Comms setup 

 .اّتْضیح کّْزضؼًْْکَ تفطیح  ًیْکواًس تَ پَ لاًسیچَ زاُط
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Job selection   

د جاب اًتخاتول    
پَ یْهفرك جسا زًْضّجاتًْْڅرَّهؼیي ًاهَ اچَ ظهًْږجاب پَ يز

. لپاضٍ لاًسي ػولیَ کاضّّّلْاًترابًْز ًتراب کړي ّياًْم 

 

 

 

 

تَ  Lest/f1ز  ّضؼتَ څرَاًتطز Job selectionز. 

ظاُطـی یْهؼیي جاب پکی  لیؽتففاضّضکّْتطځْزجاتًْْ

. زکوي تَ ففاضّضکّْ  Enterاّزٍّ کطتَ زاًتراتّْ

 

 

 

 

تایس   Coord search jobآّ Job selectionزازُن ُیطٍ ًْي چَ 

 .یًْْم اًتراب ـي
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Job name edit  
ًوم تَ تغيز ورکول د يوٍ جاب 

یي لپاضٍ لّْزتغیطک.ًْزًاهَ زهفرك ًاهَ جْړکړّپَ یْ جابیْاچَ ز

! یمَ ػول کّْ پَ لاًسی طط

 

 

 

 

 

پَ اذطکَ زٍّ ّاضٍ 

. اًتط کّْ

 

Job deletion 
  د جاب حذف کول

ّپَ ّذت کَ زٍّ لیؽوَ جاتًَْ ّجْزلطي یُْغَ ب زحصف کْلزجا

تل طَ ضاؼاَ حصف کیږي اّپَ ّاغجاتًَْ زي چَ زاًتطززکوي ز ففاض

ززي ډّل جاتًْْ  چَ ډّل ُغَ جاتًَْ زي چَ لاک یا للف ـْي ّي

! اجطاکّْ ٍز حصف لپاضٍ لاًسي ػولي

پَ ّاؼطَ تطزي لؽوت کَ هطلْب جاب اًتراب اّزاى پَ :اولَ طزيقَ

ًْ پَ ډیطٍ آؼاًی کْلای ـْحصف کړّ یي حصف کّْچَ ًوْړي جاب

! ػول کّْ ططیك پَ لاًسی
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زکوي تَ ففاضّضکّْ   Enterکلَ چَ هراهد لفحَ ظاُطٍ ـي ًْ

. ـي تطڅْ ًوړي جاب حصف

 

 

 

 

ّي جاب جاب زحصف کْلْلپاضٍ لاک ؾ زُّن لیؽن اّ: طزيقَدوُوَ 

 Commsّچَ زاّټ کْلْلپاضٍف کْاّټ کّْاّّضؼتَ یي حص

output   ّْتَ ځْاّهطلْب جاب اًتراب ک .

 

 

 

 

ًَ ّضؼتَ زجاتًْْ لیؽت ظاُطیږي اّهطتْطَ جاب  Obs Dataز 

. اّټ کّْاًتراب کّْ اّیْزاًتطپَ ّاؼطَ یي لَ 

زاّلي ططیمي پَ ـاى  ُطکلَ چَ ًوړي جاب اّټ ـًْْضتالي ػولیَ

 .اجطاکّْ

ؼتاضٍ ( *)ّي زُغي جاب تطځٌګ کْم جاب چَ لاک ـْي : ًوټ 

 Comms  اComms outputّ:اُّوساضًګَ ز .ػلاهَ هْجْزٍ ّي

setup ْکواًسًْ تالي ػولکطز تَ پَ ّضؼتٌیْ ػولي زضؼًْْ کَ ّّای .

 .ّیفل ـْی تَ پَ زٍّ تطذْػوْهي آلاتًْظط تزؼطّی آلاتل زاچَ 

 الکتطًّیکي آلي پَ ػوْهي ډّل غیطالکتطًّکی چَالکتطًّیکی اّ

 پَ ُوسی آؼاغ ظیات زلت لطي اها غیط الکتطًّیکي تطػکػ

تٌظیواتْپَ آؼاغ پَ اّتیا پَ ذپل ّاضؼطٍ زتطتیثاتْ يالیکتطًّیکی آل

 :ډّلًَْ یی ػثاضت زی لَ  زيّیفل ـْی زٍّ ترْ

 Hard setting ّا Soft setting َتفطیح یي پَ لاًسي لیؽوت ک

. ّګْضي



 

وردګ   ((رسولي))حويذالله : تزتية کووًکي    Page 12 

 

)A.E.R.C) Afghan Engineers Relation Center          دافغاى اًجيٌزاًو داړيکو هزکش   

   
[SOKKIA] 

Configuration (C ONFUG/f4) 

 تيشي تٌظيوات دټوټل ص
اُّوساضًګَ     Hard settingټْټل ؼتیفي زٍّ لیؽوَ تٌظیوات لطي 

Soft setting 

 Hard setting زُغَ تطتیثاتْڅرَ  تػثاض: یاُن ؼرت افعاض

  .اّتطتیة ـيز پیچ اّپیچ کؿ پَ ّاؼطَ تٌظین  چَزي 

 .ُوسا ضًګَ ترٌیکی تطتیثات ُن ّضتَ ّیل کیږیاّ

 Soft setting ػثاضت زُغَ : فعاضًطم ا یاُن

تٌظین څرَ ززاذلی کواًسًّْزي چَ  څرَیثاتْاّتٌظیواتْتطت

 Unitکَ ز  Setting پَ زیزهثال پَ ډّل  .تطتیة ـياّ

څرَ  ـویطل کیږی چَ زکاضزـطّع ًّْ زهِوْکاضّتطتیثْل ی

 .ـيتٌظین  Unitتطهد تایس 

لکَ څطًګَ هْچَ زؼطّی پَ تؼطیف کَ شکطکړل چَ ؼطّی زاًساظٍ  

ػلن زی پػ زُطی اًساظی لپاضٍ ّاحسات هْجْز زی ُغَ  ګیطی

 يُوساغاّزضجَ،زُْا ففاض،زُْایيّاحسات کَ زّاټي ّی یاُن ز ظاّ

  .ّي زّاحساتْ تٌظین یي ضطّضزيًْض

تایس پَ ټْټل ؼتیفي کَ ُوسی آؼاغ زؼطّی زـطّع زهرَ ًْپَ 

 !زتٌظېن لپاضٍ یی لاًسی ططیك کاضّّکړًّْآّتطتیة ّاحسات تٌظین 

: طزيقَ د کار

>CNFG/f4>Unit>enter>>Temp=C,  َػوْهي لفح

Press=hpa, Angle=degree, Dist=meter. 
 

 

 

 

ټْټل ؼتیفي هحاؼثَ کْی  ُطٍ ًمطَُطکلَ چَ  ًْی زازُن ُیطٍ

. څرَ ّی Northـطّع زهحاؼثی تایس ز
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ًْم یازیږی چَ پَ ُوسغَ  پَ Obs.Condition کواًس ز  يززی ػولی

 .پْضتٌی تطذَ کَ لطاضلطی پَ ٍلفح Unitز

الثتَ پَ  ؼطٍ اضتفاعزؼطحي اّل ـوال تیا ـطق اّّضؼتَ زتحط یؼٌي 

لپاضٍ لاًسی ططیمَ  يچَ ززی ػولی .تؼیي کړي  ػوْزي هْلیؼیت

 !کاضّّ

  :طزيقَ دکار

>CNFG/f4>Obs.Condition > enter> ▼    لفحَ ػوْهي

Coord=N.E.Z>enter>esc 

   
 

 

 

Introduction Stations  

هعزيفی کول ټوټل ستيشي تَ   وًودتيٌچ هارک
ټْټل ؼتیفي پَ تؼطیف کَ ّّیل ټْټل ؼتیفي لکَ څطًګَ هْچَ ز 

 ػثاضت زُغَ الکتطًّیکی آلی څرَ زی چَ زیْی هؼیٌی ًمطی څرَ

پَ ؼطٍ اّ  Estaingاّ   Northز ًماط یا ؼیکفًٌَْ پَ افمی فاللْ

تؼیي  زؼطحی ؼطٍتحطز  Elevationهْلیؼیت اضتفاع یاػوْزی 

 Stationًْپػ ز ښَ اّزلیك کاض زاًجاهْلْلپاضٍ تایس .ړيک

Orientation ْټْټل ؼتیفيټْټل ؼتیفي تَ هؼطفي کړّتطڅ 

کَ تؼیي هرتلفْاضتفاػاتْپَ ًمطي هرتلفی ؼیکفًٌَْ اّ ّکْلاي ـي

   !پَ لاًسی ططیمَ ػول کّْ زػولي کْلْلپاضٍ یي .ړيک

 !کْضزیٌات زاذلّْ(B.M1)ضک اّل تیٌچ هاپَ اّل لسم کَ ز

>Meas/f1>page 1>Coord/f4> َػوْهي لفح 

Stan. Orientation>enter>(H.I,H.T - زال تیٌچ هاضک

 ( کْضزیٌات 

>enter>Ok/f4 
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ي لفحي تَ ززُّنززّکوي پَ ففاضؼطٍ  ok/f4ز  پَ زُّن لسم کَ

یی لاین  اضتثاطکْضزیٌات زاذلّْاّ (B.M2)تیٌچ هاضک  زُّناّزځْ

. ػول کّْ ططیمَپَ لاًسی تالي کّْ

Back sight>enter>Coord>enter>(B.M2 Coordinate) 

>Ok/f4>(B.M2ًَْک پطیعم تْج) 

Yes/f4 

 

 

 

 

 

 

 

 

تْکوي پَ  Ok/f4زکْضزیٌاتْززاذلًَْ ّضؼتَ ز   Back sightز

ٍ پطیعم  پَ زُّن تیٌچ لفحَ کي پَ زتَ ځْ ّاؼطَ زاضتثاط لفحي

 تَزكوي  Yes/f4ز لؽکْب زُغَ ًْک تَ تْجَ کّْاّهاضک ًیؽْت

ًوْړي تیٌچ هاضک اضتثاط پَ فاللَ اّظاّیَ لاین  ّضکّْتطڅْزففاض

.  ـي
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واټي اًذاسٍ کول د ټوټل ستيشي پَ واسطَ د

Distance measuring with Total station 
تط  زیْی هفرمی ًمطی څرَپَ ّاؼطَ هْږکْلای ـْ ؼتیفي زټْټل

ًَ تط   Pt1چَ ز تلی هفرمی ًمطی اًساظٍ ّاذلْیؼٌی هؼلْهَ کړّ

Pt2 ؼتیفي  ټلّاّلَ ًمطَ ټ چَ پَ .څْهتطٍ فاللَ هْجسیت لطی 

لیؽکْب ز پطیعم ـیفی تَ تؼیټ کّْاّپَ زُّوَ ًمطَ پطیعم ًیؽْ

هطلْب لیوت لاؼتَ کّْضتَ ففاضّ Distance/F1تْجی کّْ

 .ػول کّْاّططیمَ ًسی ـکل لپاضٍ یی پَ لاچَ زػولی کْلْ ضاکْي
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: ًوټ

زازُن ُیطٍ ًْي چَ زاؼي ًمطي ُن ـتَ چَ پَ یٍْ ًمطَ ُن ؼیټ 

کْل زټْټل ؼتیفي ًاهوکي ّي یؼٌي ززضیوي ًمطي څرَ کْلاي ـْ 

تلي کْلاي ـْززي ػولیي لپاضٍ   ؟ززّاړًّمطْتطهٌځ فاللَ پیسا کړّ

ًَ پَ اؼتفازي ؼطٍ   MLM (Missing,Line,Measurment)ز 

. کْلاي ـْ

. اّززي کواًس پَ ّاؼطَ ظیات کاضًَّ اًجام کْلاي ـْ

زهیل پیسا کْل، ززاؼي زًّّمطْ تطهٌځ فاللَ چَ  :دهثال پَ ډول 

یْتطتلَ زلیسلْ ؼاحَ ًّلطي، اُّوساضًګَ ززًّّمطْ زتفاضل 

. زپیساکْلْ لپاضٍ پکاضّړل کیږي

 

MLM (Missing, Line, Measurement) 

دووًقطوتزهٌځ تفاصل ياُن فزق پيذا کول د ټوټل  د

 ستيشي پَ واسطَ
زلیْل پَ ّاؼطَ ززًّّمطْتطهٌځ فطق پیسا کّْ  لکَ څطًګَ چَ هًْږ

تیفي پَ ّاؼطَ پَ ډیطٍ ټْټل غًْپَ ُوسی ـکل هًْږکْلای ـْچَ ز

چَ .ّپیسا کړ تفاضلهٌځ ًّمطْتطځآؼاًی اّپَ ډیطزلت ؼطٍ ز زّّیا 

. یی کاضّّلَ اّططيپَ لاًسی ـکل 

 

 

 

 

>Meas/f1>Page2>Menu/f1>MLM>Enter ػوْهي

 لفحَ

Pt1َتْج >Obs/f4>Pt2َتْج >MLM  
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لیوت هثثت پَ لاغ ضاغی ًْتایس پٍْ ـْ چَ  MLMکَ چیطتَ ز 

اّلی تَ اچتَ ّالیغ زٍ اّ تطػکػ کَ چیطی ز زُّوَ ًمطَ ًظط

MLM  ًْ ًی ّضکْی چَ زُّوَ زا هغلیوت هٌفی پَ لاغ ضاغی

 .اّلی ًمطی تَ ټیټَ ّالیغ زًٍمطَ ًظط

:                                    چَ ػثاضت زي لَػولي هفرمات ّّیٌي  MLMپَ ًتیجَ کَ تَ ز  

MLM 

S:     5.695m     
H:    5.691m 

V:    0.225m 

S  زPt1  ّاPt2 کْلاي ځ ؼلْتي فاللَ تیاًْي اّتل زا چَ تطهي

. زکوي پَ کوک هؼلْهَ کړّ F3ي فاللَ پَ فیمسي زـْؼلْب

HزP1ّاPt2 تطهٌځ ؼطحي یا افمي فاللَ تیاًْي .

VزPt1 ّاPt2 تیاًْي زاضتفاع تطهٌځ فطق یا تفاظل .
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Distance measuring by MLM 

سزٍ  ( MLM)واټي اًذاسٍ کول پَ 
زټْټل پَ ّاؼطَ هًْږکْلای ـْززاؼی زًّّمطْتطهٌځ فاللَ پیسا 

زفاللي ز هٌځ لیسّؼاحَ ًْی ززی زًّّمطْتط کړّچَ تطهٌځ یی ز

! چَ پَ لاًسی ډّل ػول کّْڅرَ کاضاذلْ MLMلپاضٍ ز پیسا کْلْ
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Area calculation with Total station 
 کولدټوټل ستيشي پَ هزستَ ديوی ساحی هساحت پيذا

ا هٌظوی ؼاحی یټل ؼتیفي پَ هطؼتَ هًْږ کْلای ـْزیْی غیطزټْ

 .هؽاحت لاؼتَ ضاّړّ ؼاحی هحسّزٍ ـْی

ُغَ ؼاحی هؽاحت چَ زُیځ فْضهْل پَ ّاؼطَ زُغی هؽاحت ز یا

لپاضٍ ټْټل ؼتیفي پَ ذپل اذتیاضؼطٍ پَ  زاّل څل.پیساکړّ پیسا ًفی

چَ زػولی زاؼي ځاي کَ ؼیټ کّْتطڅْهطلْتَ ؼاحَ ّّیٌْ

. ططیمَ کاضکّْلپاضٍ یی لاًسی کْلْ
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کیږی  Recطَ اّلَ ًمطَ تْکوی پَ ّاغ Ok/f1ززی څرَ ّضؼتَ ز

ُوغَ اّلی ًمطی ؼطٍ  اُّوساهطحلَ تطُغَ ّذتَ پطهد تیایْتطڅْ

 .ّلل ـْ

 

 

 

 

کَ پَ آذطکلَ چَ اّلي ًمطَ زآذطي ًمطي ؼطٍ ّلل ـي 

Calcul/f2 ْزًوْړي ؼاحي هؽاحت پَ لاغ تَ ففاضّضکّْتطځ

. ضاـي

Area. Calculation  

Pt. Count=7  
Area=11.967m2 

 

! پَ آذطي پاڼَ کَ زتاؼي زهطلْتي ؼاحي هؽاحت ّیٌي

ټ زاّل ځل ټاضکیًْهؽاحت پیساکړّ زیْیؽاحی ززی لپاضٍ چَ :ًوټ

 تطُغَ ّذتَؼلؽلَ پَ ُوسی اّ ّضؼتَ پَ زُّوَلپاضٍ پَ اّلَ ًمطَ اّ

ُیطٍ ًْی چَ آذطی ُن زازذْ تطڅًْمطي ذلالي ـيػول کّْ

   .ـیؼطٍ ّلل  لی ًمطیًّمطَ تایس زا
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Topography Surveying with Total station 

توپوګزافی اخستل دټوټل ستيشي پَ واسطَ  
چَ یٍْ ؼاحَ ًظطپَ تْپْګطافی ؼطّی ػثاضت زُغَ ػولیی ځرَ زٍ 

. هؼطیفی کّْډیعایٌطتَ تاًسی کْضزیٌاتْاّهفرماتْ

یا ی ًمط ُطيؼطٍ ټْتل ؼتیفي کْلای ـی زپَ کوک  GPSیؼٌی ز 

ُن  یا پَ اضتفاػيؼطٍ اّ Eastاّ   Northز يی فاللافكؼیکفًٌْْ

 .تؼیي کړی  Elevation ػوْزي هْلیؼیت ؼطٍ زتحطؼطٍ

ًږ کْلای ـْ یؼٌی تْپْ ګطافی ُغَ ػولیَ زٍ چَ ز ُغی پَ ّاؼطَ هْ

زُغی اّتَ هؼطیفی کړّیعایٌطډ پَ ضڼاکَیٍْ ؼاحَ زکْضزیٌاتْلَ 

م کړّچَ زػولي کْلْ لپاضٍ پَ زُطی ًمطی هفرمات هؼلْؼاحی 

! لاًسي ططېمَ ػول کّْ
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 >Meas/f1>Page3>Rec/f3>Coord data>  َػوْهي لفح

Enter>َتْج >Obs/f2>Rec/f4>Enter,Enter>Cd cood>       

Enter>Ok/f1  =    =    =   =   ==    ===  …………. 

! هد تیایُْوسا پطّؼَ پط

ُطی ّی چَ زُطٍ ًمطی ځرَ ّضؼتَ تایس زازی ُن ُیطٍ ًَ: ًوټ

ی ّپُْیږی چَ ًوْړتایس ـی یؼٌی  ډیعایٌطز ّضکړل ًّمطی تَ کْ

. هْلؼیت لطی لؽوت کَپَ کْم  زؼطک ًمطَ

تاًسي ًمطْ تَ کْزًَّ ّضکړل ـي چَ  Descriptionsاّپَ هؼیٌْ 

  .ضٌُوا یي پَ پْضتٌي جسّل کَ ّیٌي

ذاطط ډاټا کوپیْتط تَ  زتْپْګطافي زاذؽتلًَْ ّضؼتَ زحفاظت پَ

! لَ پطهد تیایْضلیږّچَ زلیږلْلپاضٍ لاًسي هح

Download 

کوپيوتزتَ   Downloadدتوپوګزافی 
پَ  Data Downloadز زذپلي تْپْګطفي زؼاتلْلپاضٍ تایسیْؼطّیط

 لاّ ي ذْزټْلْتطهرَکړ  Sendچَ ذپلَ ډاټا کوپیْتطتَ  ّلطيیاز

اًؽتال کّْ   Hardwireضیا ُاضزّي ټْټل ؼتیفي ؼافټز تَکوپیْتط

data cable   َتؽتَ کّْ اّززي څرَ ّضؼتَ ډیطٍ هِوَ زازٍ چ

اضتثاط ز لات زټْټل ؼتیفي ززاضتثاط ّاحسات اّهفدزکوپیْتط

تَ   Comms outputاّّضؼتَ هفرماتْ ؼطٍ یْلیؽن جْړّّ

. ططیمَ کاضّّاّلاًسي ځْ
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: طزيقَ دکار

>CNFG/f4>Cooms setup>  َػوْهي لفح   

کّْ پَ زي هطحلَ کَ زټْټل اّکوپیْتطهفرمات ؼطٍ یْ

>Comms out put > 

ُْتط ّ Ok/f4پَ ّاؼطَ یي اّټ کّْاّ تطهطلْب جاب اًتراب زاى

 Obs.dataُن اًتط کّْ تطڅْ  SDRفایل تَ زاذل ـْاّز  SDRځْ

زاًتط ًَ هرکي تایس زکوپیْتط   Obs.dataتَ ّضؼْپَ زي هطحلَ کَ ز

زاکوپیْتط ؼطٍ زاضتثاط لاین کْلْلپاضٍ پَ  ؼطٍ اضتثاط لاین کړّ

اّّضؼتَ پَ کوپیْتط کَ ذلالّْ SOKKIA Linkکوپیْتط کَ ز 

Resaved data َاّپَ ُغَ کَ اّل  تConnection  اّپَ ټْټل

! اًّْضٍ ػولیَ پَ لاًسي ططیمَ.اًتط کّْ Obs.dataؼتیفي کَ 

Ok/Finish >Save SDR File>Select folder>Name 

file>Exit>Data>Total station>Open data>Drawing> 

File>Sight report>Excel file>file>Save>file 

name>Seve.    
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د ټو ټل پَ واسطَ د پايی ياُن تعويز ارتفاع پيذا کول  

Elevation measuring with Total station (REM)  

 ز یاُن ًّْضج،ب ّتؼویطّىزټْټل ؼتیفي پَ ّاؼطَ زلْړی ـْکْلا

پَ هطؼتَ  REMززپیسا کْلْ لپاضٍ کاض ّاذلْ یؼٌی  پایي زاضتفاع

افمي فاللَ اّاضتفاع پَ لاغ .پَ لاغ ضاّړّ HTاّ  Hکْلاي ـْ 

. ضاّړّچَ زػولي کْلْلپاضٍ یي لاًسي ططیمَ کاضّّ

: دهثال پَ ډول

H= 55.317m 
Ht= 22.1145 
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ضکیټ اضتفاع ز ټاتایس  لَ هرکی ًْی چَ هرکی زازُن ُیطٍ: ًوټ

 .تَ هؼطفی کړّ ؼتیفي ټْټل

. ػول کّْ ططیمَچَ پَ ػولی ـکل ؼطٍ پَ لاًسی 

 

 

 

 

 

Center line with Total station (S-O) 

دټوټل ستيشي پَ واسطَ د سٌتز لايي پيذا کول  
 ګڼل زؼٌتط لایي پیسا کْل یْ زهِیوْ زضؼًْْ زټْټل ؼتیفي څرَ 

زهرَ اّل ضیفطًػ پیساکْلْلایي زیا زؼٌتط  S-Oکیږی چَ ز

چَ زؼوت ظاّیَ ّضتَ ّیل  dHAکَ ټْټل ؼتیفي  پَ جْړّّیؼٌي

تاًسي یْ هؽیطاّپَ ُوسي لفطکّْپَ هؽیط North کْږي ز

Obs/f1  چَ پَ زضیوَ لفحَ زS-O لطي لطاضکَ پَ کواًس

. کّْ Recپَ یْ هفرك ًاهَ  Observeًْهړي اّاذلْ

ځٌګَ هْچَ پَ هرکي  ًچ هاضکًْْهؼطفي لکَپَ زُّوَ هطحلَ کَ زتي

پَ ُوغَ لیؽن  کړٍکاضکَ ز ټْټل ؼتیفي تَ  ؼتیفًٌَْ هؼطفي زضؼًْْ

ًَ لّزاذلْ ّزکْضزیٌاتز.زتیٌچ هاضکًَْ هؼطفي کّْټْټل ؼتیفي تَ 

! تالي ػولیَ پَ لاًسي ططیمَ اًجاهّّْضؼتَ 

>Meas/f1>Page2>Menu/f1>S-O>Enter>َػوْهي لفح 

S-O data>Enter. 
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▲S-O/f2>▲S-O>Coordinate Cl (1.2.3.4.5.6………) 

Ok/f4> Ok/f4>Ok/f4>dHA= (0.00.0)>
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ًَ ّضؼتَ لاًسي لفحَ ظاُطیږي چَ پَ  زففاضز زکوي   Ok/f4ز 

. ازاهَ یي لاًسي ػولیَ اجطا کّْ

 

 

 

 

تطڅْ زکوي تَ ففاضّضکS-O/f2ّْ لفحَ کَ پْضتٌياّغ پَ زي 

ظاُطٍ ـي چَ زًوړي ظاّیي  dHAیا   ّیَزؼوت ظا

. پیسا کیږي هؽیط پَ لفط کْلْ ز ؼٌتط لایي

ٍ ،ثاًیَ لفطـٍْ پَ زضجَ ،زلیك  dHAپیساکړیؼٌي کلَ هْچَ هؽیط

ًْي لفط  S-O  Sڅْ هْتطُّْ Obs/f1تطُغَ ّذتَ ُوسي هؽیط

ُطکلَ چَ زهؽیطظاّیَ اّپَ هؽیطهْلؼیت زپیسا کړپَ ُغَ ًمطَ .کړي

.ړًّمطي تَ زؼطک ػطضي تمؽیوات ّک ُوغَضظىّتطڅؼید ُّْ
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Lay out Constructor with Total station 

(Set out line) 
 شي پَ واسطَيټوټل ستد تعويزخط اًذاسی د

پَ ښَ لْضت  ذط اًساظي ززی پَ ذاططچَ زیٍْ تؼویطیا ؼاذتواى 

ز ټْټل پَ اؼتفازی ؼطٍ لاًسی ػولیَ اّزلیك ډّل ؼطٍ اًجام کړًّْ

زُطڅَ زهرَ لاحة زکْض هْلیؼیت زکْض ًظط زّّ ًمطْتَ .ّّاًجام

ي چَ ُغَ زّي ًمطي تَ زتؼویططْل ّي چَ ُوسي ړتؼیي ک

 چَ. زًّّمطْ تَ یي ُن ػطن اُّن ًْضٍ ذط اًساظي لْضت ًیؽي

. لاًسي ططیمَ یي ػولي کّْپَ 
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تطڅْ کّْاّل اّزُّن ؼیکفي کْضزیٌات هؼطفي پَ اّلَ هطحلَ کَ ز

. ززّاړّ ًمطْتطهٌځ فاللَ اًّظطُغَ ًمطْتَ هحاؼثَ ّکړي

. زػولي کْلْلپاضپَ لاًسي ططیمَ ػول کّْ

>Meas/f1>Page2>Menu/f1>Set out line  َػوْهي لفح

   

 

 

 

>Enter>Stn.Orientation>interaction>Define base 

line>Enter 
 

Edit>Enter>► 
 

 

 

Edit>Ok/f4> 

 

 

Ok/f4> 
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پَ هؽیط یْلیوت ّضکّْ ټْټل ؼتیفي ًظط  Lengthپسي ّذت کَ ز

چَ پَ لفط کْلْؼطٍ یي .ُوغَ لیوت تَ زؼوت ظاّیَ تفکیل کْي

  .کْلاي ـْهطلْتَ ًمطَ پَ لاغ ضاّړّ

 

 

 

 

 

 

 

 

! پَ ّاؼطَ کْلاي ـْهؽیط زًمطي پیساکړّ dHAیؼٌي زپْضتٌي 

! یت زًمطي پیساکّْپَ ضٌُوایي هْلیغ Obs/f1اّپَ ُوسي هؽیطز

 

 

 

 

زپیساکْلًَْ ّضؼتَ پَ ػطضي هؽیطُن کْلاي ـًْمطَ  Lengthز

کَ لیوت ّکّْ  Offsetپیساکړّچَ زػطضي ًمطي زپیساکْلْلپاضٍ پَ 

  !اّتالي ُوغَ پْضتٌي ػولیَ پطهد تیایْ
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یا زضجَ  90تایس  ضیعمهِال پز ټْټل پَ ّاؼطَ ز ذط اًساظی پط :ًوټ

ُوطٍ ًمطَ چَ پطیعم زلیك ًّیْل ـی  ځکَ څْهطٍ زًّیْل ـيػوْ

. زلیمَ پَ لاغ ضاځي

 

Bridge coordinates implementation with 

Total station  

دټوټل پَ واسطَ  تطثيكدپل دپايوکورديٌاتو
زهرَ تایس زپل زتطثیك پَ زپل زکْضزیٌاتْ پَ تطثیك کی زُطځَ ًَ 

! تاًسی ځاى ّپُّْْهفرماتْ

 ّپل لایًٌَْ چَ لسم کَ زپل زاّږزّالی پَ اهتسازآذطی ؼٌتط لپَ ا

کْضزیٌات ّلطّاّ ُوساضًګَ  Pt2اّ  Pt1یؼٌی  ّيؼطٍ ّلل

 .هٌځ فاللَ هؼلْهَ ّیززّاړًّمطْتط

 زپیساکْلًَْ هرکی تایس لسم کَ هِوَ زازٍ چَ زکْضزیٌاتْ پَ زُّن

dHA  زNorth ـیپَ هؽیطتاًسی لفط. 

 ؼطٍ پَ لاًسی زیٌاتْپَ زاذلْلّْضؼتَ کْلای ـْز ًمطی زکْض

 .تْګَ ػول ّکړّ

 

چَ زډیعایٌطلَ ططفَ ّضکْل  Dataزپل زپایْ پَ تطثیك کَ کْهَ 

  Set out lineکیږي ُوغَ ډاټا تطثیك کیږي اّزتطثیك لپاضٍ زُوغَ 
چَ پَ ذط اًساظي کَ هْکاضتطي اذؽتَ زلتَ ُن پَ ُوسي ططیك 

.  کاضیږي
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ًْی چَ زپل پَ کْضزیٌاتْ کَ پطیعم تایس آتتطاظّ  زازی ُن ُیطٍ: ًوټ

 زضجی ظاّیَ جْړٍ 90طحی ؼطٍ ًّیْل ـی یؼٌی زځوکی زافمی غ

.  کړي
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دګولايی تطثيك دټوټل ستيشي پَ واسطَ  
څرَ ی تطثیك زټْټل ؼتیفي پَ ّاؼطَ یْزهِین تطیٌْزضؼًْْزګْلای

کْلای ـْپَ ډیطٍ ږی چَ زټْټل ؼتیفي پَ ّاؼطَ هًْږـویطل کی

. تطثیك کړّ ګْلایی یاضيیٍْ هغ کن ّذت کَپَ ډیط پَ ډیطزلت آؼاًی
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! زګْلایي زتطثیك پَ ّذت کَ تایس لاًسي ټکي پَ ًطط کَ ًّیؽْ

 زStart point  ّا  End point  اُّوساضًګَ زIP یا 

Intersect point ّکْضزیٌات ّلط .

  زضجَ ًّیْل ـي 90پَ ډیط زلت اّزتطثیك پطهِال پطیعم. 

  کلَ چَ زګْلایي ؼٌتطیي پیساـي ًْػطضي ًمطي یاOffset  

زتطثیك لپاضٍ یي لاًسي .یي تایس ُن پَ ټْټل ؼتیفي پیساکړّ

! ططیمَ کاضّّ

>Meas/f1>Page2>Menu/f1>                                                   َػوْهي لفح

Set out arc>Enter> 

 

 

 

 

پَ اّل لسم کَ ټْټل ؼتیفي تَ تیٌچ هاضکًَْ 

... تَ ضځْ Define arcهؼطفي کّْاّّضؼتَ 

 

 

 

 

زاّلي ًمطي کْضزیٌات 

پَ   Ok/f4ّضکّْاّز

ّاؼطَ زُّوي لفحي 

تَ ځْپَ ُوسي ـاى ز 

! زُّن ًمطي کْضزیٌات ُن ّضکّْ
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ي پَ ّاؼطَ زکن Ok/f4ززُّوي ًمطي زهؼطفي کْلًَْ ّضؼتَ ز

زګْلاي هفرمات تفکیل کیږي چَ پَ لاًسي تمْیطکَ یي ّیٌي 

  !پطهد تیایْ ٍاّتالي ػولیَ لاًسي ططیك

 

 

 

 

ّضتَ لیکْاّز  180پَ ذاًَ ّضتَ  Angleز

Enter پَ ففاض ؼطٍ ګْلایي تفکیل کیږي .

  پَ اؼتفازٍ ؼطٍ  Ok/4پَ ُوسي ؼلؽلَ 

Arc ّاOffset چَ ز.ظاُطیږيArc   َپ

پَ ّاؼطَ   Offsetضکعي ذط اّز ّاؼطَ م

. زؼطک ػطضي تمؽیوات اًجاهیږي

 

 

 

 

 . پَ لیؽن اجطاکیږي  S-O dataًْضٍ تالي ػولیَ ز

 


